Chapter 178

Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 Cross-Over Design

Introduction

Senn (2002) defines a cross-over design as one in which each subject receives all treatments and the objective is to study differences among the treatments. The name cross-over comes from the most common case in which there are only two treatments. In this case, each subject crosses over from one treatment to the other. It is assumed that there is a washout period between treatments during which the response returns back to its baseline value. If this does not occur, there is said to be a carry-over effect.

A 2×2 cross-over design contains two sequences (treatment orderings) and two time periods (occasions). One sequence receives treatment A followed by treatment B. The other sequence receives B and then A. The design includes a washout period between responses to make certain that the effects of the first drug do not carry over to the second. Thus, the groups in this design are defined by the sequence in which the drugs are administered, not by the treatments they receive. Indeed, higher-order cross-over designs have been used in which the same treatment is used at both occasions.

Cross-over designs are employed because, if the no-carryover assumption is met, treatment differences are measured within a subject rather than between subjects—making a more precise measurement. Examples of the situations that might use a cross-over design are the comparison of anti-inflammatory drugs in arthritis and the comparison of hypotensive agents in essential hypertension. In both cases, symptoms are expected to return to their usual baseline level shortly after the treatment is stopped.

The sample size calculations in the procedure are based on the formulas presented in Lui (2016).

Advantages of Cross-Over Designs

A comparison of treatments on the same subject is expected to be more precise. The increased precision often translates into a smaller sample size. Also, patient enrollment into the study may be easier because each patient will receive both treatments. Finally, it is often more difficult to obtain a subject than to obtain a measurement.
Disadvantages of Cross-Over Designs

The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires additional assumptions. It may be difficult to separate the treatment effect from the period effect, the carry-over effect of the previous treatment, and the interaction between period and treatment.

The design cannot be used when the treatment (or the measurement of the response) alters the subject permanently. Hence, it should not be used to compare treatments that are intended to provide a cure.

Because subjects must be measured at least twice, it is often more difficult to keep patients enrolled in the study. It is arguably simpler to measure a subject once than to obtain their measurement twice. This is particularly true when the measurement process is painful, uncomfortable, embarrassing, or time consuming.

Technical Details

The $2 \times 2$ crossover design may be described as follows. Randomly assign the subjects to one of two sequence groups so that there are $n_1$ subjects in sequence one and $n_2$ subjects in sequence two. In order to achieve design balance, the sample sizes $n_1$ and $n_2$ are assumed to be equal so that $n_1 = n_2 = n = N/2$.

Sequence one is given the control (A) followed by the treatment (B). Sequence two is given the treatment (B) followed by the control (A).

Cross-Over Design

The discussions that follow summarize the results in Lui (2016) on pages 57-70. Consider a $2 \times 2$ cross-over design and let $Y_{ij}^{(g)}$ represent the response category for the $j$th subject, $j = 1, \ldots, n_g$, in the $i$th period ($i = 1, 2$), in sequence $g$ ($g = 1, 2$) on an ordinal scale with $L$ possible categories, $C_1 < C_2 < C_3 < \cdots < C_L$. Assume that subjects in sequence 1 are given the control or standard in period 1 and then the experimental treatment in period 2. Assume that subjects in sequence 2 are given the experimental treatment in period 1 and then the control or standard in period 2. If we define $\eta$ as the relative effect of the treatment to the control, then $\eta > 0$ indicates that the response category, $C_k$, of a subject receiving the treatment tends to be greater than the response category of a subject receiving the control or standard. Similarly, $\eta < 0$ indicates that the response category, $C_k$, of a subject receiving the treatment tends to be less than the response category of a subject receiving the control or standard.

For a randomly selected subject from sequence $g$ ($g = 1, 2$), the probability that the measured response in period 1, $Y_{1j}^{(g)}$, is less than the measured response in period 2, $Y_{2j}^{(g)}$, is

$$\Pi_c^{(g)} = P\left(Y_{1j}^{(g)} < Y_{2j}^{(g)}\right) = \sum_{r=1}^{L-1} \sum_{s=r+1}^{L} \pi_{rs}^{(g)}$$

where

$$\pi_{rs}^{(g)} = P\left(Y_{1j}^{(g)} = C_r, Y_{2j}^{(g)} = C_s\right) \text{ with } r = 1, 2, \ldots, L \text{ and } s = 1, 2, \ldots, L.$$

Similarly, the probability that the measured response in period 1, $Y_{1j}^{(g)}$, is greater than the measured response in period 2, $Y_{2j}^{(g)}$, is

$$\Pi_p^{(g)} = P\left(Y_{1j}^{(g)} > Y_{2j}^{(g)}\right) = \sum_{r=2}^{L} \sum_{s=1}^{r-1} \pi_{rs}^{(g)}.$$
The generalized odds ratio, \( GOR(g) \), of subject responses between periods 1 and 2 for a randomly-selected subject from group \( g \) is defined as
\[
GOR(g) = \frac{\prod_{C}^{(g)}}{\prod_{D}^{(g)}}.
\]

The generalized odds ratio, \( GOR \), for the treatment versus the control is then
\[
GOR = e^\eta = \sqrt{\frac{GOR^{(1)}}{GOR^{(2)}}}.
\]

**Test Statistic**

For a two-sided test of the hypotheses
\[
H_0: GOR = 1 \quad \text{vs} \quad H_A: GOR \neq 1
\]
the power and sample size calculations are based on the test statistic
\[
Z = \frac{\log(GOR)}{\sqrt{\text{Var} \left( \log(GOR) \right)}}
\]
which is asymptotically distributed as standard normal with
\[
\text{Var} \left( \log(GOR) \right) = \frac{1}{4} \sum_{g=1}^{2} \frac{\hat{\Pi}_C^{(g)} + \hat{\Pi}_D^{(g)}}{n_g \hat{\Pi}_C^{(g)} \hat{\Pi}_D^{(g)}}.
\]
The null hypothesis is rejected in favor of the alternative at level \( \alpha \) if
\[
|Z| > Z_{1-\alpha/2}
\]
where \( Z_{1-\alpha/2} \) is the upper \( 1 - \alpha / 2 \) percentile of the standard normal distribution. One-sided tests reject the null hypothesis at level \( \alpha \) if
\[
|Z| > Z_{1-\alpha}
\]
where \( Z_{1-\alpha} \) is the upper \( 1 - \alpha \) percentile of the standard normal distribution.

**Power Calculation**

If \( \hat{GOR} \) is the estimate of the generalized odds ratio, then \( \hat{\eta} = \log(\hat{GOR}) \) has asymptotic variance
\[
\text{Var} \left( \log(\hat{GOR}) \right) = \frac{V \left( \log(\hat{GOR}) \right)}{n},
\]
where
\[
V \left( \log(\hat{GOR}) \right) = \frac{1}{4} \sum_{g=1}^{2} \frac{\prod_{C}^{(g)} + \prod_{D}^{(g)}}{\prod_{C}^{(g)} \prod_{D}^{(g)}}.
\]
Also define the standard deviation of \( \log(\text{generalized odds ratio}) \) as
\[
SD = \sqrt{V \left( \log(\hat{GOR}) \right)}
\]
Derived from the sample size formula given in Lui (2016) on page 68, the power for the two-sided test of 
\( H_0: GOR = 1 \) versus \( H_A: GOR \neq 1 \) is
\[
\Phi \left( \frac{|\log(GOR_1)|}{SD} - Z_{1-\alpha/2} \right)
\]
where \( \Phi() \) is the standard normal distribution function, \( GOR_1 \) is a value of the generalized odds ratio under the alternative hypothesis, and \( Z_{1-\alpha/2} \) is the upper \( 1 - \alpha/2 \) percentile of the standard normal distribution. The sample size calculation formula for a two-sided test is
\[
n = \text{Ceiling} \left\{ \left( \frac{\left( Z_{1-\alpha/2} + Z_{1-\beta} \right) SD}{\log(GOR_1)} \right)^2 \right\}
\]
The power for a one-sided test is
\[
\Phi \left( \frac{|\log(GOR_1)|}{SD} - Z_{1-\alpha} \right)
\]
where \( Z_{1-\alpha} \) is the upper \( 1 - \alpha \) percentile of the standard normal distribution. The sample size calculation formula for a one-sided test is
\[
n = \text{Ceiling} \left\{ \left( \frac{\left( Z_{1-\alpha} + Z_{1-\beta} \right) SD}{\log(GOR_1)} \right)^2 \right\}
\]

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment that has already been run.
Select Effect Size (GOR1) when you want to calculate the minimum effect size that can be detected for a particular design.
Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 Cross-Over Design

Test

Alternative Hypothesis
Specify whether the test is one-sided or two-sided. When a two-sided hypothesis is selected, the value of alpha is split in half. Everything else remains the same.

Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal means when in fact the means are different.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal means when in fact the means are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size

n (Sample Size per Sequence)
This is the sample size of each sequence or group (AB and BA) in the cross-over design. The individual sequence sample sizes are assumed to be equal such that the total sample size is equal to \( N = 2n \).

You can enter a single value such as 50 or a list of values using the syntax 50 100 150 200 250 or 50 to 250 by 50.

Effect Size – Generalized Odds Ratio for Treatment/Control

GOR1 (Generalized Odds Ratio|H1)
Enter a value for the generalized odds ratio for treatment versus control under the alternative hypothesis, H1. The power calculations assume that this is the actual value of the generalized odds ratio.

You can enter a single value such as 2 or a series of values such as 2 2.5 3 or 2 to 3 by 0.5 in the range GOR1 > 0, GOR1 ≠ 1.
Effect Size – Standard Deviation of Log(Generalized Odds Ratio)

Standard Deviation Estimation Method
Choose how the standard deviation of the log generalized odds ratio (SD) will be estimated.

The options are

- **Enter SD Directly**
  Input log generalized odds ratio SD values directly. This option allows you to input any value for SD, regardless of how it was estimated.

- **Use Estimated Cumulative Proportions**
  Input cumulative proportions from a previous 2x2 cross-over study. These estimates are used only to calculate the standard deviation and are not necessarily related to the value used for GOR1.

Standard Deviation (SD)
Enter a value for the standard deviation of the log generalized odds ratio, SD.

Estimating SD using Previously-Estimated Discordant Cell Proportions
The standard deviation may be estimated using cumulative proportions from a previous study using the method of Lui (2016) on page 67, where

\[ SD = \sqrt{\left( \frac{1}{4} \sum_{g} \frac{[\Pi C(g) + \Pi D(g)]}{[\Pi C(g) \times \Pi D(g)]} \right)} \].

PASS will calculate the SD for you using this method if you set Estimation Method to “Use Estimated Cumulative Proportions” and enter cumulative proportions from a previous 2x2 cross-over study.

Cumulative Proportions
Enter the corresponding cumulative proportion from a previous 2x2 cross-over study.

The estimated proportions are defined as follows:

Sequence 1 = C \rightarrow T
Sequence 2 = T \rightarrow C

\[ \Pi C(g) = \text{Proportion of (Response from Period 1 < Response from Period 2) in Sequence g} \]
\[ \Pi D(g) = \text{Proportion of (Response from Period 1 > Response from Period 2) in Sequence g} \]

The standard deviation of the log generalized odds ratio is calculated by PASS as described in Lui (2016) on page 67 as

\[ SD = \sqrt{\left( \frac{1}{4} \sum_{g} \frac{[\Pi C(g) + \Pi D(g)]}{[\Pi C(g) \times \Pi D(g)]} \right)} \].

These estimates are used only to calculate the standard deviation of the log generalized odds ratio and are not necessarily related to the value used for GOR1.

Range: 0 < \[\Pi C(g) \leq 1\], 0 < \[\Pi D(g) \leq 1\], \[\Pi C(g) + \Pi D(g) \leq 1\]
Example 1 – Power Analysis

Suppose you want to consider the power of a balanced cross-over design with ordinal data where the test is computed based on the generalized odds ratio for sequence sample sizes between 50 and 200. The generalized odds ratio to detect is 2 and the estimated standard deviation of the log generalized odds ratio is 2.5. The significance level is 0.05.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 Cross-Over Design procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on Test (Inequality), and then clicking on Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 Cross-Over Design. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>n (Sample Size per Sequence)</td>
<td>50 to 200 by 25</td>
</tr>
<tr>
<td>GOR1 (Gen. Odds Ratio</td>
<td>H1)</td>
</tr>
<tr>
<td>Estimation Method</td>
<td>Enter SD Directly</td>
</tr>
<tr>
<td>Standard Deviation (SD)</td>
<td>2.5</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Sequence Sample Size</th>
<th>Total Sample Size</th>
<th>Gen. Odds Ratio</th>
<th>Standard Deviation</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power 0.50022</td>
<td>50</td>
<td>100</td>
<td>2.00</td>
<td>2.50</td>
</tr>
<tr>
<td>0.67045</td>
<td>75</td>
<td>150</td>
<td>2.00</td>
<td>2.50</td>
</tr>
<tr>
<td>0.79178</td>
<td>100</td>
<td>200</td>
<td>2.00</td>
<td>2.50</td>
</tr>
<tr>
<td>0.87283</td>
<td>125</td>
<td>250</td>
<td>2.00</td>
<td>2.50</td>
</tr>
<tr>
<td>0.92446</td>
<td>150</td>
<td>300</td>
<td>2.00</td>
<td>2.50</td>
</tr>
<tr>
<td>0.95617</td>
<td>175</td>
<td>350</td>
<td>2.00</td>
<td>2.50</td>
</tr>
<tr>
<td>0.97506</td>
<td>200</td>
<td>400</td>
<td>2.00</td>
<td>2.50</td>
</tr>
</tbody>
</table>

References

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
n is the sample size in each sequence (or group).
N is the total combined sample size from both sequences.
GOR1 is the generalized odds ratio under the alternative hypothesis.
SD is the user-entered standard deviation of log generalized odds ratio. This is estimated from a previous study.
Alpha is the probability of rejecting a true null hypothesis. It should be small.

Summary Statements
For a 2x2 cross-over design, a sample size of 50 in each sequence for a total of 100 achieves 50.022% power to detect a generalized odds ratio of 2.000 using a two-sided test with a significance level of 0.050 when the standard deviation is 2.500.

Dropout-Inflated Sample Size

<table>
<thead>
<tr>
<th>Dropout Rate</th>
<th>Sample Size</th>
<th>Dropout-Inflated Enrollment Sample Size</th>
<th>Expected Number of Dropouts</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n</td>
<td>N</td>
<td>n'</td>
</tr>
<tr>
<td>20%</td>
<td>50</td>
<td>100</td>
<td>63</td>
</tr>
<tr>
<td>20%</td>
<td>75</td>
<td>150</td>
<td>94</td>
</tr>
<tr>
<td>20%</td>
<td>100</td>
<td>200</td>
<td>125</td>
</tr>
<tr>
<td>20%</td>
<td>125</td>
<td>250</td>
<td>157</td>
</tr>
<tr>
<td>20%</td>
<td>150</td>
<td>300</td>
<td>188</td>
</tr>
<tr>
<td>20%</td>
<td>175</td>
<td>350</td>
<td>219</td>
</tr>
<tr>
<td>20%</td>
<td>200</td>
<td>400</td>
<td>250</td>
</tr>
</tbody>
</table>

Definitions
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the course of the study and for whom no response data will be collected (i.e. will be treated as “missing”).
n and N are the evaluable group and total sample sizes, respectively, at which power is computed (as entered by the user). If n subjects from each group are evaluated out of the n' subjects that are enrolled in the study, the design will achieve the stated power, N = 2n.
n' and N' are the number of subjects that should be enrolled in the study in order to end up with n and N evaluable subjects, based on the assumed dropout rate. n' is calculated by inflating n using the formula n' = n / (1 - DR), with n' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J., and Wang, H. (2008) pages 39-40.). N' = 2n'.
d and D are the expected number of group and total dropouts, respectively. d = n' - n and D = 2d.
Charts Section

This report shows the values of each of the parameters, one scenario per row. This plot shows the relationship between sample size and power. We see that a sample size of just over 100 per sequence is required to detect a generalized odds ratio of 2 with 80% power.
Example 2 – Calculating Sample Size when Estimating the Standard Deviation from a Previous Study (Validation using Hand Calculations)

This example demonstrates how to calculate the sample size when estimating the standard deviation of the log odds ratio from data in a previous study using the method in Lui (2016) on page 67. In this example we’ll find the sample size required to detect a generalized odds ratio of 2 with 80% power at a significance level of 0.05, with the standard deviation estimated from cumulative proportions from a previous study.

Suppose the cumulative proportions are

\[ \Pi_C^{(1)} = 0.11 \]
\[ \Pi_D^{(1)} = 0.29 \]
\[ \Pi_C^{(2)} = 0.23 \]
\[ \Pi_D^{(2)} = 0.11 \]

Using the method of Lui (2016) on page 67, SD is calculated as

\[
SD = \sqrt{\frac{1}{4} \sum_{g=1}^{2} \frac{\Pi_C^{(g)} + \Pi_D^{(g)}}{\Pi_C^{(g)} \Pi_D^{(g)}}}
\]

\[
= \sqrt{\frac{1}{4} \left( \frac{0.11 + 0.29}{0.11(0.29)} + \frac{0.23 + 0.11}{0.23(0.11)} \right)}
\]

\[
= 2.5484
\]

PASS will calculate this SD value for you automatically when you input the cumulative proportions.

Since there is no example given for this calculation in the book, we’ll validate this procedure using hand calculations. The sample size calculated by hand using the equation on Lui (2016) page 68 is

\[
n = Ceiling \left\{ \left( \frac{Z_{1-\alpha/2} + Z_{1-\beta}}{\log(GOR_1)} \right)^2 \right\} = Ceiling \left\{ \left( \frac{(1.960 + 0.842)2.5484}{\log(2)} \right)^2 \right\}
\]

\[
= Ceiling\{106.0965\}
\]

\[
= 107
\]
Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 Cross-Over Design procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on Test (Inequality), and then clicking on Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 Cross-Over Design. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>GOR1 (Gen. Odds Ratio</td>
<td>2</td>
</tr>
<tr>
<td>Estimation Method</td>
<td>Use Estimated Cumulative Proportions</td>
</tr>
<tr>
<td>ΠC(1)</td>
<td>0.11</td>
</tr>
<tr>
<td>ΠD(1)</td>
<td>0.29</td>
</tr>
<tr>
<td>ΠC(2)</td>
<td>0.23</td>
</tr>
<tr>
<td>ΠD(2)</td>
<td>0.11</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Sample Size</th>
<th>Total Sample Size</th>
<th>Gen. Odds Ratio</th>
<th>Standard Deviation</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>0.80332</td>
<td>n = 107</td>
<td>N = 214</td>
<td>GOR1 = 2.000</td>
<td>SD* = 2.548</td>
</tr>
</tbody>
</table>

This report indicates that the estimated standard deviation using the method of Lui (2016) is 2.548 and the required sample size is 107 per sequence. The cumulative proportions are also listed. These values for SD and \( n \) computed by PASS match our hand calculations above.